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Introduction

These release notes describe the latest enhancements to Optivity Campus™ 7.0.1. 
They supplement your Optivity Campus 7.0 documentation set. Be sure to re
these notes before using the Optivity® network management software.

The following information is included:

• New Features

• New Hardware Support

• Agent Support

• Operating System Support

• Operational Notes

• Bay Networks Technical Publications

• How to Get Help

New Features

Optivity Campus 7.0.1 has the following new features:

• Now works with the following new network management platforms in 
addition to HP OpenView Workgroup Node Manager:

— HP OpenView Network Node Manager version 5.0x for NT (must be 
purchased separately)

— Tivoli TME 10 NetView version 5.0x for NT (must be purchased 
separately)

• Includes updated SpeedView™ 3.2.1 software

• Includes updated Quick2Config™ 1.3.2 software

• Includes support for Centillion™ versions 2.0 and 3.1 agents

• Includes Switch Monitor support for all Bay Networks® switches

• Includes support for Accelar Device Manager and VLAN Manager 1.3

• Includes support for Netwave Air Surfer Manager.

Note: The Optivity Campus 7.0.1 documentation is supplied in Adobe 
Acrobat format on the Optivity Campus 7.0.1 Documentation CD. See the 
Optivity Campus 7.0.1 CD booklet for more information.
896-007-M 1



Release Notes for Optivity Campus 7.0.1

he 
New Hardware Support

Optivity Campus 7.0.1 for Windows offers network management support for t
following new Bay Networks devices:

• Includes support for the following new Bay Networks devices:

— Accelar™ 105x, 1100 and Accelar 1200 routing switches

— Centillion C20, C50, and C100 switches

— System 5000BH modules

— Model 5505S, Model 5505PS, Model 5575A-C and Model 5575A-F 
token ring host modules with Distributed Automatic Beacon Removal 
(DABR)

— Model 5616SA Ethernet/Fast Ethernet modules

— Model 5625 Autosense switch module

— Model 5660-FX, Model 5625, and Model 5665 switch modules

— BayStack™ 600 Series

— BayStack 450 Switches

— BayStack 350 10/100/1000 Switches

— BayStack 303 and BayStack 304 Ethernet Switches

— BayStack 250 Series Autosense Hubs

— BayStack 200 Series 100BASE-TX Hubs

— BayStack 150 Series 10BASE-T Hubs

— BayStack 350 Series Autosense Switches
2 896-007-M
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The new supported devices and the Optivity Campus applications that sup
them are shown in Table 1.

Table 1. Device Support by Application
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Accelar 1108, 1216 X X

Accelar 1100, 1200 X X X

Accelar 1050, 1051 X X

Centillion C100 X X X X X X X X

Centillion C50 X X X X X X X X

Centillion C20 X X X X X X

System 5000BH X X X X X X X X

Model 5505, 5575 w/DABR X X X X X X X X

Model 5616SA X X X X X X X X X X X

Model 5660-FX, 5665 X X X X X X X X X X

Model 5625 X X X X X X X X

BayStack 600 X

BayStack 450-12T X X X X X X X X

BayStack 450-24T X X X X X X X X

BayStack 350-12T X X X X X X X X

BayStack 350-24T X X X X X X X X

BayStack 304 X X X X X X X X

BayStack 303 X X X X X X X X

BayStack 250 X X X X X X X X X X X

BayStack 200 X X X X X X X X X X X

BayStack 150 X X X X X X X X X X X X
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Agent Support

Table 2 lists the most current agents, configuration templates, and protocols 
supported by Optivity Campus 7.0.1. 

Note: Optivity Campus 7.0.1 does not include agent image files for 
Bay Networks products. To obtain agent images, you must enroll in the 
Bay Networks Software Services program. For more information, contact 
Bay Networks Software Subscription Services at one of the following telepho
numbers
1-800-736-2666 (North America) or
1-408-450-3666 (International).

Table 2. Agent Support

Agent Software
Standard
Agent

Advanced
Agent

Advanced 
Analyzer 
Agent

Image File
Configuration
File

Model 810M version 1.0.3 X 810M103.IMG 810M103.CFG

Model 271x version 3.5.0 X 271x350K.IMG TR350.cfg

Model 271x version 5.1.5 X 271x515K.IMG TR515.cfg

Model 271xSA version 2.0.0 X 271SA200.IMG 271SA200.CFG

Model 2810 version 3.3 X X b2810x33.IMG b2810x33.CFG

Model 2810 version 4.0 X X b2810x40.IMG b2810x40.CFG

Model 281x version 5.3.3 X X 281X533.IMG 281x533.CFG

Model 281xSA version 2.0.0 X 281SA200.IMG 281SA20.CFG

Model 331x version 5.3.3 X X 331X533.IMG 331x533.CFG

Model 331xA version 5.3.3 X X 331A533.IMG 331A533.CFG

Model331xS version 5.3.3 X 331S533.IMG 331S533.CFG

Model 331xSA version 2.0.0 X 331SA200.IMG 331SA200.CFG

Model 3410 version 2.0.0 X 3410_200.IMG 3410_200.CFG

Model 351x version 3.5.1 X 351x351K.IMG TR351.CFG

Model 351x version 5.1.5 X 351x515K.IMG TR515.CFG

Model 351xSA version 2.0.0 X 351SA200.IMG 351SA200.CFG

Model 5310 version 1.5.1 X 5310_151.IMG 5310_151.CFG
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Model 5310A/SA version 
2.0.1

X X 5310A201.IMG 5310A201.CFG

Model 5510 version 2.0.0 X X 5510_200.IMG 5510_200.CFG

Model 5616 version 1.5.3 X X 5616_153.IMG 5616_153.CFG

System 5000BH version 3.2.1 AXF32100.bh or 
T8N32101.bh

BayStack Ethernet Workgroup 
Switch 
(6 port) version 3.2.9

X SWITCH.BIN 
SWITCH2.BIN

N/A

BayStack Ethernet Workgroup 
Switch 
(7 port) version 3.2.9

X EWG7S329.ZIP* N/A

BayStack 
10BASE-T Ethernet NMM 
version 2.0.0
Standard Agent

X BBSE_200.IMG BBSE_200.CFG

BayStack 
10BASE-T Ethernet NMM 
version 2.0.0
Advanced Agent

X ABSE_200.IMG ABSE_200.CFG

BayStack 
10BASE-T Ethernet NMM 
version 2.0.0
Advanced Analyzer Agent

X SBSE_200.IMG SBSE_200.CFG

BayStack 
10BASE-T DCM version 2.0.0

X LN11_200.IMG

BayStack 100BASE-T 
Ethernet NMM version 2.0.0

X 100BT200.IMG 100BT200.CFG

BayStack 150 version 3.0 B15x_300.img B15x_300.cfg

BayStack 250 version 3.1 B25x_310.img B25x_310.cfg

BayStack 200 version 1.0.2 B200_310.img B200_310.cfg

BayStack 301 version 2.1.0 EXX21010.301

BayStack 302 version 2.1.0 X B30x_210.img B30x_210.cfg

BayStack 303, 304
version 2.1

BS30x_210.img BS30x_210.cfg

Table 2. Agent Support (continued)

Agent Software
Standard
Agent

Advanced
Agent

Advanced 
Analyzer 
Agent

Image File
Configuration
File
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*The following comments apply to the image file used for the BayStack Ethernet Workgroup Switch 
(7-port) version 3.29.: 
This image file is included in a .ZIP file which you unpack to a separate directory using the PKUNZIP utility. 
Once unpacked, carefully read the README.TXT file for instructions on how to download the image file. 
The image file unpacked from the EWG7S329.ZIP file can only be used with the BayStack Ethernet Workgroup 7-Port 
Switch and not with the BayStack Ethernet Workgroup 6-Port Switch.

BayStack 350, 350T, 350FDH 
version 2.0.2

B350_202.img

BayStack 450 12T, 24T
version 1.1

B4501012.img

BayStack Token Ring NMM 
version 1.2.1
Standard Agent

X BST_121.IMG BST_121.CFG

BayStack Token Ring NMM 
version 1.2.1
Advanced Agent

X ABST_121.IMG ABST_121.CFG

BayStack Token Ring NMM 
version 2.0.0
Advanced Analyzer Agent

X SBST_200.IMG SBST_200.CFG

BayStack Token Ring DCM 
version 2.0.0

X n511_200.img

53DN DCM
version 2.0.0

LN11_200.img

Distributed 5000™ host 
firmware version 1.3.0

5d03_130.img

Model 281xx version 2.1.0 28k210.img

Model 282xx version 2.1.0 28k210.img

Model 58xxx version 2.1.0 58k210.img

Centillion100 version 3.2.1 AXF32100.100 or
T8F32100.100

Table 2. Agent Support (continued)

Agent Software
Standard
Agent

Advanced
Agent

Advanced 
Analyzer 
Agent

Image File
Configuration
File
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Operating System Support

Optivity Campus 7.0.1 for HP OpenView (Windows) supports only Windows 9® 
and Windows NT® Workstation version 4.0. Note that IP is the only supported 
protocol under Windows NT. When you run Optivity Campus 7.0.1 on Window
95 or Windows NT Workstation version 4.0, you must disable Dynamic Host 
Configuration Protocol (DHCP).

Operational Notes

The following sections describe advisories and known problems that pertain 
operating Optivity Campus 7.0.1 on your management station.

General

The following general notes apply to a variety of Optivity applications:

• The BayStack 150 is not a multisegment device. However, it does allow fo
the isolation of individual units from the segment. To isolate a unit from th
segment, use Expanded View to open a Show Profile window for the unit 
set the Attachment Point parameter to 0. To reconnect a BayStack 150, s
Attachment Point back to 1.

• Model 5505P host modules must be equipped with Model 559 EMTs in or
to be recognized by Ring Manager and by the FPU table.

• Access Node Hub (ANH™) devices initialize the repeater MIB to 0xFF 
instead of 0. Thus, invalid numbers appear in the fields of the Repeater M
Diagnostics display shown in Figure 5-19 in Chapter 5, “Monitoring Your 
Network,” of Using Optivity Campus 7.0 for Windows.

• When a Model 559 daughterboard is connected to a Model 5505P modul
LANarchitect™ shows the Model 559 device as port 21 on the network 
management module (NMM).

• In a routing environment, Optivity Campus 7.0.1 does not support multipl
networks on a single router interface (a practice known as multinetting).

Note: Isolating a BayStack 150 Series hub using the Attachment Point 
parameter disables all management functions except the setting of the 
Attachment Point parameter.
896-007-M 7
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• In historic line charts, when a display is zoomed in range, all points in the
graph with values greater than the zoom range are normalized. To view th
actual value of all the points, increase the zoom range.

• If you have isolated a cluster for troubleshooting purposes, by definition y
have prevented it from communicating. Thus, if you use Expanded View™ to 
monitor an isolated cluster, there is no connectivity information available 
this cluster—only unit, slot, and port information is displayed.

• If you installed Optivity Campus in its default directory. Use the following 
DOS commands to backup the database:

cd C:\opt\db

erase *.taf

erase *.log

backup *.* a:/s

• If a database error (DBLayer) occurs when you start Optivity for HP 
OpenView, this error could indicate that your hard disk is full and the databas
could not be written. Remove files from your hard disk and restart the sys

• If you run a program that uses Windows Sockets (WinSock) on a Windows
workstation, a gradual increase in the memory used by the operating sys
might occur over time, especially if the program opens and closes a large
number of sockets. You can free the resources associated with a program by 
exiting the program. If you quit and restart Windows 95, the memory is freed. 

• Bay Networks recommends that you use a PostScript printer when printin
from Optivity applications. Also, Optivity does not support the Print to File
feature.

• For the IP Trap Receiver table registration to occur on a BayStack Ethern
Workgroup Switch, the agent must be set to default factory settings (such as 
“Read/Write community string=Private”) and Optivity Campus 7.0.1 must 
have “DEFAULT=Private” in the c:\opt\bin\cpasswd.ini file (the default 
setting for Optivity Campus 7.0.1).

• In some network configurations with a mix of Bay Networks and Cisco 
Systems routers, the HP OpenView Network Node Manager alarm log rep
error messages regarding duplicate MAC addresses. This problem is cau
by the different types of routers storing MAC addresses differently in their 
respective ARP caches.
8 896-007-M
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Installation

The following notes pertain to installation issues:

• When you re-install or upgrade Optivity Campus 7.0.1 the prompt: “Do yo
want to save old Database files?” is displayed. If you answer Yes, files are 
saved in the opt\saved directory.

Refer to “Installing Optivity Campus 7.0 for HP Open View Workgroup Nod
Manager and Tivoli TME 10 NetView,” Appendix C, “Using the Database 
Maintenance Tool,” in the section titled “Restoring a Backed Up Database

• Optivity Campus 7.0 is fully upgradeable to 7.0.1. You do not need to rem
the Campus 7.0 software to perform this upgrade.

• The Optivity Campus 7.0.1 Software CD automatically starts the setup 
program after the CD is inserted. On some computers, the Windows Auto
feature either has been disabled or does not function properly. If the setu
program does not start after about a minute, either start the setup progra
manually as described in the Getting Started guide, or refer to your computer 
system documentation for instructions on enabling the Autorun feature.

• If during the upgrade the following error message is displayed:

“Setup could not clean up existing Application Directories 

Please remove <directoryname> from your system” check the 

following:

a. Close all programs and restart your system before continuing the 
upgrade.

b. If old Optivity directories were manually deleted choose a different 
location to install Optivity.

c. If you are an advanced user, remove the “ccc.exe” entry in 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Curr
entVersion\AppPaths

• When you are running the setup installation process the Registration files
Optivity options must be selected.

• If you have installed the Air Surfer Manager application used for NetWave™ 
devices but Campus 7.0.1 fails to detected it, be sure it has been enabled

To enable Air Surfer Manager support:

a. Install the Air Surfer Manager application.
896-007-M 9
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b. Set the “AIRSURF” variable in the synopt.ini file.

Example: AIRSURF=C:\APWebMgr\APWebMgr.exe

c. Restart Optivity Campus 7.0.1.

• Optivity Campus 7.0.1 supports up to 80 subnets and 250 manageable de
defined for the monitored network. 

• During IPX discovery, Optivity uses the attached IPX server to do discove
If the database is not complete, set the following variable in the discover.ini 
file:

TryAltServers=1

• When you upgrade from a previous version of Optivity Campus to 
version 7.0.1, you should manually restore the previously saved Optivity 
database. To restore the database, copy all of the files from the \opt\saved 
directory to the \opt\db directory.

• The error messages, DBLayer Error -23, DBLayer Error -26, and DBLaye
Error -40 could indicate that the database transaction file (vista.taf) and the 
log files (user*.log) in the Optivity database directory have been corrupted.
correct this problem, perform the System Cleanup procedure described in
Chapter 3 of Getting Started with Optivity Campus 7.0 for HP OpenView 
Workgroup Node Manager. 

• During installation, you must provide a gateway address. In a routerless 
environment, enter the gateway address 1.1.1.1. 

Platform Software

The following sections contain operational notes regarding the network 
management platform software supported by Optivity Campus 7.0.1.

HP OpenView Workgroup Node Manager

• HP OpenView D.01.02, version 7.2 supports variable length subnet mask
configurations. However, Optivity Campus 7.x does not support this featu
and will not discover any devices in the network using variable subnet ma
10 896-007-M
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• When an Accelar 1100 or Accelar 1200 switch is included on an HP 
OpenView map, OpenView may fail upon receiving traps from the Accelar 
device. This problem occurs because the Accelar routing switches send 
SNMP v2 traps by default, and OpenView can only handle SNMP v1 traps
prevent this problem, configure the Accelar device as follows to send SNM
v2 traps:

In the Accelar Device Manager application, choose Edit > Chassis and cl
on the Trap Receivers tab. Then find the entry for the Optivity Campus 
management station in the Trap Receivers list and change the Version en
from V2 to V1.

• The HP OpenView Internetwork map comes to the foreground when you 
select any menu option. This problem only occurs after you select an opt
from the Applications menu.

• If the HP OpenView Workgroup Node Manager History list of traps is 
allowed to grow too large (greater than about 25000 entries), opening the
History list can appear to halt the computer. Stopping OpenView using th
Windows Task Manager or Close Program dialog box in this situation can
corrupt the alarm database, which will prevent OpenView from starting. T
prevent this problem, use the HP OpenView Customize Alarms dialog bo
configure OpenView to delete alarms before the History list grows too larg
Note that Acknowledging traps does not delete them, it moves them into 
History part of the Alarm Log. 

• If you are using HP OpenView Workgroup Node Manager as a standalon
application on your PC and you also install Optivity Campus 7.0.1, verify t
the settings in your OVWIN.INI and TRAPMGR.INI files are configured 
properly. 

• During the installation, Optivity 7.0.1 makes some modifications to your 
existing HP OpenView Workgroup Node Manager (OpenView 7.2) .ini and 
devices files. Optivity 7.0.1 creates a backup copy of the .ini and devices files 
(for example, devices.001, devices.002) in the c:\opt\saved directory. Use the 
saved files to return customization to your .ini files. (Note, however, that 
Optivity 7.0.1 does not maintain the original backup copies of your 
trapmgr.ini and ovwin.ini files if Optivity is reinstalled.)

• Optivity Campus 7.0.1 is supported on HP OpenView D.01.02 which com
bundled on the installation CD. If you have a different version, please 
uninstall it prior to installing Optivity Campus 7.0.1.
896-007-M 11
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• Windows requirements for Optivity Campus 7.0.1 on HP OpenView WNM
are:

Windows 95 with Microsoft TCP/IP, Microsoft IPX/SPX stack.

Windows NT 4.0 with Microsoft TCP/IP stack.

• Any open Optivity Campus applications are closed whenever HP OpenVi
starts and loads a map. 

• The following error message may be displayed if Optivity is closed and then 
reopened within less than one minute: “Exit Optivity first before logging in
again.” This error happens because the logout and login processes take 
than 30 seconds to execute. To avoid this problem, wait at least one minu
after you log out of Optivity before you log back in or restart Windows.

• If you double-click an icon on the HP OpenView map and the submap is n
displayed, do the following:

— Choose Locate Object from the Window menu.

— Select a device that is part of the map that could not be displayed.

— Select Rename Submap from the Edit menu.

— Delete the DOT at the end.

• When HP OpenView faults with an OVNETMON error, exit OpenView and
reboot your system.

• When you use the HP OpenView polling feature, you may receive an “Ou
Buffer Condition” error. This error occurs in the Windows 95 environment 
all of the following conditions exist:

— The Optivity station is included in the polling list.

— The Optivity station is set as the default gateway.

To correct this problem, remove the Optivity station from the polling list.

• In a switching environment, the color of a device symbol for an Advanced
agent NMM on the HP OpenView map might not reflect current device status.
To ensure that accurate symbol colors are displayed on the map, add the 
Advanced agent NMMs you are managing to the HP OpenView polling lis
and start the polling process.

• If you see the “OVWIN caused a GPF in module <unknown>” message, s
down and reboot the system. Then delete the following files:
12 896-007-M
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C:\OPT\DB\*.taf and *.log
C:\*.net
C:\OPT\OV\*.lck and ovalins.*

• If the SNMPAltRouterCommunity= parameter is set in the OVWIN.INI file, 
the OpenView discovery process uses this parameter and excludes the 
SNMPDefaultCommunity= parameter.

• Do not change the OpenView subnet map name for compound objects (s
as segment or subnet symbols). The subnet map name and compound o
name must be the same in order for OpenView to open the subnet map w
you double-click on the compound object.

• When you use the HP Openview SNMP compiler to compile a MIB file whi
contains other MIB files and receive the following compiler error:

“The selected files depend on the following MIB file: <list of MIB files>. 
Please compile these MIB files before attempting to compile this selectio

Check the following for possible causes.

• The selected MIB file does not have a dependency on one or more of
MIB files listed.

• Check the MIB files contents for correct format.

• Select all MIB files that have dependencies at the same time before 
compiling or adding them to the database.

• The Optivity Campus database synchronization overwrites the host name
with an IP address which creates the same object twice in the HP OpenV
database. A workaround is to select the hostname from the menu bar, ch
Autodiscovery > Discover > Update.

HP OpenView NNM and Tivoli TME 10 NetView

Operational Notes

• Original registration files stored in <NMS platform>\conf, <NMS 
platform>device, and <NMS platform>\fields are saved to <NMS 
platform>\saved prior to updating them with BayNetworks entries.

These files are overwritten by files currently in use every time you perform
installation process. However these files are not removed by the uninstall 
process so you must restore them to their original location after an uninst
896-007-M 13
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• Campus Command Center (CCC) may be launched or shut down 
independently of HPOV NNM or NetView.

However, you should never close or use Windows Task Manager to kill 
Optivity Campus processes.

• Check the PATH environment variable before you start NNM or NetView f
the first time after installing Optivity 7.0.1. Follow the guidelines in the 
Getting Started Guide to verify and restore, if needed, the PATH variable to i
correct value.

• The Optivity Campus installation for NNM opens up the NNM console duri
the registration process. You may clear and close it to resume installation

• Towards the end of the installation process, cmd windows pop up 
momentarily as the setup program updates the platform databases. This 
take quite some time depending on the size of the current NNM or NetVie
database. However, if any of these processes appear to be hung for an 
unreasonable length of time, you may halt them and manually perform th
update later. 

To manually update the platform database, execute the following comma
in the order given.

— For Tivoli TME 10 NetView

ovstop netmon

ovw_config

ovstop

ovstart ovwdb

ovstart ovtopmd

ovtopofix -a

ovstart

Note: If the computer hangs after you issue the ovstop  command, open 
the Windows NT task manager and end all processes named ov*.exe (such a
ovtrapd.exe).
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— For HP OpenView Network Node Manager

ovstop

ovstart ovwdb

ovw -fields

ovstart ovtopmd

ovstop netmon

ovtopofix -a

ovstart

• You should configure NetView and Network Node Manager to check for 
essential daemons at frequent intervals and restart them, if necessary. Failu
of Netmon, which may occur because of some other associated process f
prevents Campus Command Center and other related applications from 
receiving traps. Furthermore, TrapRdr32, the interface between NetView and 
Optivity, gets into a loop waiting for traps from the platform and takes up a
very high percentage of CPU time.

Agent Software

The following operational notes pertain to issues related to agent software tha
general in nature or exhibit symptoms in more than one Optivity Campus 
application:

• The Model 331X version 5.2 agent does not display any data in the utiliza
and frame size graphs in the RMON summary window. In the Report 
Manager, the packet, octet, and utilization graphs are displayed as 0. To 
these problems, use agent version 5.3 or later.

• All segment-level pop-up pie charts and displays for a Distributed 5000 o
BayStack Ethernet Hub are either “0” or return an “Invalid Object” message 
on the pop-up status line.

• For the Distributed 5000, BayStack Ethernet, and BayStack 100BASE-T 
hubs, the Show Profile display is unable to show the Location, Name, Vers
Contact, and Description MIB object information.
896-007-M 15
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Specifically, when SNMP requests are performed with group #1 index (Bo
index and Interface Number) on Distributed 5000 and BayStack Ethernet 
hubs, the agent returns an “Invalid Object” message. Additionally, when 
SNMP requests are performed with group #8 index (Ethernet and Segment 
Number), the agent returns a value of zero for backplane segment numbe
2, and 3. For backplane segment numbers greater than 3, the agent retur
“Invalid Object” message.

• Token ring agents do not ping the router. As a result, IP hub discovery may
discover the IP addresses of representative NMMs in your token ring sub
If this is the case, use the Add Device feature to manually add them.

• After an agent in a device is upgraded, Optivity Campus 7.0.1 does not re
the correct agent version until its database has been updated. To update
Optivity Campus database, in Expanded View of the device, select Config
> Validate.

Topology 

The following notes pertain to topology issues:

• Optivity Campus 7.0.1 supports up to 250 manageable devices.

• Campus Command Center Autodiscovery does not work when an 
Accelar 1200 or Accelar 1100 routing switch is designated as the default 
gateway.

• The correct network topology may not be discovered if multiple bridges are
connected to a network segment through a device that has Standard age
software installed. To correct this problem, install Advanced agents.

• Optivity could take up to one minute to reflect topology changes for Syste
3000™ devices and up to five minutes for System 5000™ devices, depending 
on network size.

• When a topology change trap is received from a hub containing a Model 5
NMM and a Model 58000 switch, Optivity will continuously report topolog
change traps at every polling cycle. The workaround is to restart Optivity.
However, if another topology change trap is received, the cycle restarts.

• For the best topology discovery, Bay Networks recommends you always 
the most current agents with all of your Bay Networks devices. Note that 
Optivity fully supports these mixtures of older agents to ensure correct 
topology:
16 896-007-M
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— Version 1.3x/1.4/1.5 and version 5.3x agents in any combination (wor
with BayStack 100BASE-T agent version 1.1)

— Version 1.2.2 and version 5.2 agents in any combination

— Version 1.0 and version 1.1 agents in any combination

— Version 1.4 agent for the switch and version 1.5 agent for the other 
NMMs, as required for System 5000 with the Model 58000 switch 
module (works with BayStack 100BASE-T agent version 1.1)

IPX Protocol

Note the following points regarding the IPX protocol:

• If you want IPX support on a Windows 95 workstation, you must install th
Microsoft NetWare component when you are configuring the managemen
station.

• If you add IPX communications stacks to the management station after 
installing Optivity, you must reinstall Optivity to ensure that all IPX-related
files are installed.

• If you remove IPX communications stacks from the management station a
installing Optivity, you must delete the IPX references from both the 
[Optivity] and [LNMS] sections of the synopt.ini file. Find the line that reads:

Protocols = IP, IPX

and edit it to read:

Protocols = IP

On HP OpenView Workgroup Node Manager platforms, you must also 
remove references to the IPX protocol from the OPT\OV\OVWIN.ini file:

— In the [Discovery] section, find the line:

IPXDiscoverAll=Yes

and change it to read:

IPXDiscoverAll=No

— In the [OpenViewSNMP] section, find the line:

SNMPNetIpx=yes

and change it to read:

SNMPNetIpx=no
896-007-M 17
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Miscellaneous Problems

The following miscellaneous problems have been observed:

• On the Windows 95 platform, printing tables across the network does not 
work. However, locally printing tables is possible.

• The Optivity Multimedia Tutorial may not work with some video and audio
drivers. If this happens, reboot the system and do the following:

— Run README.EXE in your WINDOWS directory.

— Verify that your hardware and driver configurations are supported by 
QuickTime for Windows. (README.EXE lists some of the video 
adapters and sound cards that are not supported by QuickTime for 
Windows.)

If you have a video driver that is not supported, you can replace the dr
with the Windows default Standard driver and run the tutorial.

Bugs Fixed

• The error “Database Synchronization, Please Wait” no longer occurs whe
you open or create an HP OpenView map.

• When you add a BayNetworks router manually using HP OpenView, the 
device no longer appears as a Switch Node™. (57290)

Application Notes

The following sections list operational notes and known problems for various
Optivity Campus 7.0.1 applications. Agent-related issues are listed under the
application in which the symptoms are observed. Such issues are usually list
under Operational Notes because they represent problems with the agent sof
and not with the application.
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Agent Manager

These notes pertain to the Agent Manager application.

Operational Notes

• The Agent Manager application needs both the MAC address and the IP 
address of each device to list the device in the main dialog box. Dependin
how many devices you are upgrading, you can bring up Expanded View o
Flat Network View or run Node Discovery to ensure that your database is
fully populated.

• To show all NMM entries in Agent Manager, you must run the Optivity No
Discovery utility.

• When you upgrade an agent using Agent Manager, the boot router settin
the device must be properly configured. Otherwise, Agent Manager will n
be able to upgrade the agent.

• The Revision column of the Image Upgrade dialog box displays the hardw
revision letter instead of the firmware revision as stated in the documenta
and online Help.

Known Problems

• Agent Manager does not support BayStack 200, BayStack 250, BayStack
or BayStack 450 series devices. See the documentation supplied with the
devices for instructions on upgrading the agent software. 

• In Agent Manager, during the upgrade procedure, entering the agent key
the Agent Key feature causes the Image Upgrades dialog box to display 
key. The # agent XXXXXXXX (agent key) is written to the agent 
configuration file. Open the configuration file and delete the pound symbo
(#) from the agent key before upgrading the agent. 

• Agent Manager may not be able to recommend the correct agent image 
upgrade version for devices that cannot distinguish an agent maintenanc
release (for example, for version 5.31, 5 is the major release, 3 is the min
release, and 1 is the maintenance release). After you perform the upgrade, the 
Status column shows In Progress when it should display Successful. If yo
relaunch Agent Manager, the Image Upgrade dialog box displays agent im
version 5.30 in the Version column instead of 5.31. It also displays 5.31 in
Recommendation column instead of none even though you have success
downloaded the upgraded agent image version.
896-007-M 19
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Alarm Manager

These notes pertain to the Alarm Manager application.

Operational Notes

• Online help is only available for those traps that arrive after the Alarm 
Manager window is opened. For all other traps, the online Help opens to 
listing of the available Help topics.

Known Problems

• Alarm Manager does not properly report traps received from Bay Network
routers.

Bugs Fixed

• Alarm Manager no longer displays duplicate alarms from a BayStack 350
device that uses older versions of agents.

• In Optivity Campus 7.0.1, Alarm Manager shows details for Threshold 
Exceeded traps received from agents.

Campus Command Center

These notes pertain to the Campus Command Center (CCC) application.

Operational Notes

• When many device icons turn red despite being reachable via Ping, it ma
indicate that the community strings in the device database are incorrect. This 
situation can occur if you upgraded or reinstalled Optivity, or reset the 
Optivity database, and then opened an old .ccc file. 

If this situation occurs, choose Applications > Set Community String in 
Campus Command Center, and use the Set Community Strings dialog bo
enter all of the read community strings used on your network. Click on Ye
when the application prompts whether you want to discover community 
strings.
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• In CCC the Applications menu contains the launch point for generic 
applications like Expanded View and Threshold Manager. “Air Surfer 
Manager” is not a generic application that can be launched on all 
BayNetworks devices, it can only be launched from the device sensitive m
of the NetWave wireless hub.

Bugs Fixed

• In Campus 7.0.1 stack probes are now discovered correctly. (75612)

Device Manager (For Accelar Routing Switches)

These notes pertain to the Device Manager application.

Operational Notes

• When you start Device Manager by right-clicking an Accelar device in the
Campus Command Center Switches folder, the Open Device dialog box 
opens. You must enter the IP address of the target Accelar device in the 
Device Name text box in order to start the Device Manager application.

• There are no launch points for Accelar Device Manager either in Optivity 
Campus program group or in the HP OpenView menu bar. (81623)

Expanded View

These notes pertain to the Expanded View application.

Operational Notes

• When you run Expanded View on a BayStack 250 device, the Auto Sens
display shows incorrect speed information. This is caused by a problem w
the BayStack 250 version 1.0 agent software.

• When you run Expanded View on a BayStack 250 device, the Show Node
table is empty. This is caused by a problem with the BayStack 250 version
agent software.
896-007-M 21
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Known Problems

• When you run Expanded View on a Centillion C100 switch, the Bridge 
Groups Table (choose Config > Bridge Group) does not show any bridge 
groups for token ring modules.

• A problem occurs when you use Expanded View and then LANarchitect for a 
System 5000 device or any of the supported switching devices (Models 
281XX, 28200, or 58000). When you try to view the Expanded View windo
for the second time, the window is blank. To make the window display 
correctly, choose Config > Validate.

• The BayStack 350 Autosense Switches reports LED status of the media 
dependent adapters incorrectly.

• When you show the profile of two different token ring NMMs in the same 
chassis the same data is displayed for both NMMs. This usually occurs o
chassis with multiple NMMs. (56735)

Bugs Fixed

• In Optivity Campus 6.2, Expanded View no longer halts on a General 
Protection Fault error when the software insertion status of a BayStack 5
port is set.

• Expanded View now detects all the ports of 5307PS-HD modules when th
or more 5307PS-HD modules are installed in a System 5000 chassis.

• Expanded View now correctly displays the LEDs of BayStack 350-FHD 
Autosense Switches.

• When you use Boot Profile in Expanded View the boot mode now change
bootp and the EEPROM write status to WriteEeprom. (56783)

• In Expanded View, fault diagnostic values are now returned from (3502A 
3502B) host modules that were being managed by a Model 351x NMM. 
(57656)

• When you use Expanded View to show the profile of a feeder node, you c
now change the current port speed. (56255)

• Expanded View now displays correct configuration ring attachment 
information for the BayStack 500-series token ring hubs.

• Expanded View no longer displays the error “invalid command line option
when a token ring port on a System 5000 hub is unwrapped.
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• A General Protection Fault (GPF) on Windows 95 no longer occurs when 
launch Expanded View against a Model 5310SA with agent version 1.6.0 w
more than three 5307PS-HD modules. (57615)

• When you launch Expanded View on a Baystack 152, port LEDs are now
correctly reported. (57784)

• When you launch Expanded View on a Model 3314SA hub, the attachme
unit interface (AUI) uplink port is now shown correctly as a Fiber port. 
(56537)

Flat Network View

These notes pertain to the Flat Network View application.

Operational Notes

• To show a switch in Flat Network View, you must use the Describe feature
enter the IP address and device type for the switch.

• In a network with Baystack 100BASE-T or 10BASE-T hubs with basic 
agents, topology may not be supported. Flat Network View may use thes
basic agents as a representative network management module (NMM), b
these agents do not support network topology. To make topology work 
correctly, assign another agent as the representative NMM using the Des
feature.

• If you have a problem seeing a BayStack 28115 Ethernet Switch (formerl
known as the LattisSwitch™ hub), a BayStack 28200 Modular Ethernet 
Switch, or a BayStack Ethernet Workgroup Switch in Flat Network View, 
make sure its MAC and IP addresses are in the device database. Launch
LANarchitect or Expanded View to ensure that your database is complete
with both IP and MAC addresses for these switches.

• In a switching environment with Bay Networks switches, the color of a dev
symbol in Flat Network View or Segment View may not reflect current device 
status. To correct this problem, use the Validate feature to update the Fla
Network View or Segment View display.
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Known Problems

• Flat Network View cannot show interconnection information for switched 
networks.

• Flat Network View does not effectively support combinations of 28100-series
28200-series, and BayStack Ethernet Workgroup switches.

• Flat Network View does not support the Model 5616 Ethernet/Fast Ethern
NMM.

• Flat Network View does not show correct topology for segments that cont
BayStack 250 devices.

• Token ring bridge icons stay blue in Flat Network View.

LANarchitect

These notes pertain to the LANarchitect application.

Operational Notes

• Although you can display a BayStack Ethernet hub in LANarchitect, softw
switching for segments is not supported by the agent software. However,
Move button is not deactivated for BayStack Ethernet hubs. For BayStack
Ethernet hubs, when you use LANarchitect to move a cluster to different 
segments the following message is displayed:

Move Cluster - Fail to attach cluster

• In the Model 5580 Token Ring Router Module, only interface 4 supports 
LANarchitect. Interfaces 1, 2, and 3 are hardwired to ring segments 
1 through 3.

• When you use LANarchitect to move ports between backplanes on Mode
5605P or 5675P-FX Autosense host modules, observe the following poin

— Each port has both 10 mb/sec (Ethernet) and 100 mb/sec (Fast Ether
connections. The 10 mb/sec connection is the connection the port us
when Autosense detects that the connected device is communicating 
mb/sec. The 100 mb/sec connection is the connection the port uses w
Autosense detects that the connected device is communicating at 10
sec.
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— When you drag ports between backplanes, LANarchitect always mov
the port connection (either 10 mb/sec or 100 mb/sec) that matches th
speed of the target backplane. The configuration of the other connectio
determined by the settings of the AutoSense Setting dialog box, that 
opens when you select Option > Set Config Mode. These settings are
follows:

• Under the Symmetrical Number setting, the other connection is 
moved to the matching backplane of the same number.

For example, dragging a port from E-Bkpl # 3 to E-Bkpl#5 moves t
10 mb/sec connection to E-Bkpl #5 and also moves the 100 mb/s
connection to FE-Bkpl #5.

• Under the Isolate setting, the other connection is isolated.

For example, dragging a port from E-Bkpl # 3 to E-Bkpl#5 moves t
10 mb/sec connection to E-Bkpl #5 and also isolates the 100 mb/
connection.

• Under the Ignore setting, the other connection remains unchange

For example, dragging a port from E-Bkpl # 3 to E-Bkpl #5 moves t
10 mb/sec connection to E-Bkpl #5 but does not change the 100 m
sec connection from its previous value.

Known Problems

• LANarchitect cannot be used to move a Model 28200 DCM to a different p
on the switch.

• LANarchitect shows the BayStack 10BASE-FL hub and either the 10BASE
hub AUI MDA or 10BASE-FL MDA as separate components even though 
they are in the same cluster as other ports on the same hub.

• For Model 5616SA NMMs, LANarchitect does not properly identify DCMs
second interfaces, or PPP interfaces. This causes the application to represen
these elements with the magnifying glass icon normally used for NMMs.

Note: When you drag Autosense ports between backplanes of different types
always validate the setting from the device after each successive operation.
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Bugs Fixed

• LANarchitect now shows segment attachment information for all ports on
Distributed 5000 host modules when more than 6 units are stacked.

• LANarchitect now shows all of the available 5307PS-HD ports and any of
ports of other modules inserted in the chassis when three or more 5307PS
modules are installed.

• A General Protection Fault (GPF) on Windows 95 no longer occurs when 
launch Lan Architect against a Model 5310SA with agent version 1.6.0 w
more than three 5307PS-HD modules. (57615)

• You can now launch LANarchitect for a System 58000-series switch from
Applications menu of HP OpenView Workgroup Node Manager.

• LANarchitect now displays port 1 of a BayStack 500-series token ring hub
a module cluster (port 1-24), using the token ring module cluster icon.

Nodal View

These notes pertain to the Nodal View application.

Operational Notes

• In NodalView™, Distributed 5000 (version 1.3 and later) and BayStack 
Ethernet hub (version 1.3 and later) nodes turn blue because they do not
support the statistics they are being polled for. This is true for the Model 
5310SA Agent version 1.5.1, the BayStack 100BASE-T Agent version 1.1
the Model 331x Agent version 5.3.3, and the BayStack 50x Agent version
1.1.2.

• The Net Address (IPX) display property in NodalView is not available. Ne
Address always displays the IP address.

Known Problem

• In Nodal View, when you choose Properties > Net Address the IP addres
for some devices are not displayed.

The same is true in the RMON Summary View. When you select View by N
Address (default is MAC address), some of the devices do not display the
addresses. (56865)
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• In Nodal View, to partition a user from their attached port, click on the ico
representing the user (PC) attached to a port of a managed hub, right-clic
the line representing the PC and select Fault > Disable. However, when y
try to re-enable the port using Fault > Enable, the process fails. The 
workaround is to enable ports through Expanded View. (57447)

Bugs Fixed

• You can now launch NodalView against a Model 5510 NMM with a 2.0 ima
and not receive the error “NV-003 cannot get topology data.” (73060)

• When you launch Nodal View against a Model 5616 A/SA 10/100 Etherne
NMM node statistics are now displayed. (79999)

• Unit/port information and the node network addresses are now displayed
when you use Find Node to locate a node connected to a Distributed 500
hub. (56724)

Node Security Manager

This note pertains to the Node Security Manager application.

• Node Security Manager does not work with BayStack 150 or BayStack 2
devices. This is due to problems with the BayStack 150 version 2.0 agent
the BayStack 250 version 1.0 agent.

Out-of-Band Manager

This note pertains to the Out of Band Manager application.

• If out-of-band communication times out while modems are negotiating a 
connection, you should add the following information to the 
c:\opt\bin\async.ini file:

[Modem]
WaitConnect=44
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Report Manager

These notes pertain to the Report Manager application.

Operational Notes

• Bay Networks recommends that you routinely back up your report databa
by copying and saving the c:\opt\db\dcsdb.* files. 

• When you use Report Manager, you must always provide the RMON 
Interface Number in the “Device Details Page.”

• In Report Manager, “DCM A” may not correspond with “RMON Interface 1.” 
To determine the interface to DCM mapping, launch the RMON Summary 
application for the device in question. If the interface number is not available,
uncheck the “Select RMON agent” box and the program defaults to collec
information from the NMM. Data collected will then be from the segment th
the NMM is attached to.

• When Report Manager is abnormally terminated, the following message i
displayed when the Report Manager is relaunched: “DBLayer Error, inval
db_address (code = -6).” After this error is displayed, a dialog box is 
displayed with a list of reports. Open each report to determine data is 
accessible. If not, delete that data collection from the Report Manager.

Known Problems

• Report Manager does not support BayStack 250 devices.

• Report Manager supports Model 5616 modules to the segment level; por
level statistics are not supported.

• In Using Optivity Campus 7.0 manual, page 8-16, the manual indicates th
Report Manager you can choose File > Open to open a file that has been 
as a tabbed or HTML file. This menu does not exist.

Bugs Fixed

• When you use Report Manager to gather data on a BayStack 10BaseT H
running agent version 1.50 or later, the error: “REPM-002: Failed to start 
collection for <IP address> Please check collection parameter and try ag
no longer displays. (57416)
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• Report Manager now correctly reports utilization statistics for Fast Ethern
devices based on formulas for 10-BASET Ethernet.

• In Campus 7.0.1, you can now set up Report Manager to gather data on 
BayStack 50x token ring hub running agent version 1.2.0. (59362)

• When you set up a report against a Model 5510 NNM version 1.60 or 2.0
users no longer receive the following error:

"REPM-002: Failed to start the collection for -<ip address>. 
Please check collection parameters and try again."

Ring Manager

These notes pertain to the Ring Manager application.

Operational Notes

• The following items pertain to the TR Embedded Manager window:

— For a Model 5505 token ring module, changing the value in the Mode
column from CoreStatistics to Roving will not result in Roving appeari
in the Mode column for all entries pertaining to that module.

Instead, one of these entries continues to display a value of CoreStat
in the Mode column. It is not possible to obtain statistics for that entry

— For the Model 5575X token ring module, it is not possible to obtain 
accurate statistics if the RingIn port is not inserted. 

— For the Model 5502 token ring module, the EmbeddedMgmt value is n
accurately represented in the Capabilities column. 

— If a module has “EmbeddedMgmt” capability and the mode is set to 
“CoreStatistics,” only one entry should exist for that module. If more th
one entry is present, wait for some period of time and then validate ag
to allow the multiple entries to collapse as one. In the multiple entry st
it is not possible to obtain statistics for that module.

Bugs Fixed

• The Ring Manager menu option in Campus Command Center is now ena
when you select a BayStack 50x /SA token ring agent. (56645)
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RMON Applications

These notes pertain to the Optivity Campus RMON applications.

Operational Notes

• To view full RMON data for the BayStack 50x Token Ring Hub, start up th
application for the two interfaces.

• To view files you saved using the RMON Summary Filter and Capture 
feature, use pdecode.exe, located in the \opt\armon\ directory.

• When you run RMON applications for a System 5000BH chassis in which
more than one MCP module is installed, note that each MCP module can
gather RMON statistics for the half of the chassis in which it is installed (s
2-8 or slots 9-13). Use the Probe Connectivity dialog box in the Campus 
Command Center to make sure that the IP address specified is for the M
installed in the half of the chassis for which you want to gather RMON 
statistics.

• Optivity Campus RMON applications support System 5000BH modules a
Centillion C50N and C50T switches only if they are running version 2.2 o
later agents and the etherStatsTable has already been created. To create the 
etherStatsTable, see the following readme file on the Optivity Campus 
Software CD:

<CD drive>:\wgn\unsupprt\readme.est

• When you use RMON Summary against a BayStack 28000 Switch runnin
agent version 2.0 or earlier the following error is generated:

“(RMONSVR-019) There is no Probe Monitoring <IP Address>,Slot:x, Po
y”

As a workaround, edit the c:\opt\bin\rmon_opt.ini file and find the lines 
below:

:28K family; provide default support

1.3.6.1.4.1.45.3.15.1=0

1.3.6.1.4.1.45.3.13.5=0

1.3.6.1.4.1.45.3.17.3=0

Modify all values on each subnet line replacing “0” with “2”. If the RMON 
server process is not closed at this time, wait a few minutes until it is clos
before relaunching RMON Summary.
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Known Problems:

• The RMON Filter and Capture application does not work with either Stac
Probe or with System 5000 token ring devices.

Bug Fixed

• Threshold Manager™ now supports BayStack 28000 and BayStack 58000 
Series switches when you use agent version 2.0 or later.

RouterMan

These notes pertain to the RouterMan™ application.

Operational Notes

• If your RouterMan Browse Profiles display for an Agent Identification Serv
shows a time out in the status bar, close RouterMan and restart the applic

• In RouterMan, some of the XNS Host Table and Filter Table displays may
always show “Get” in the status bar.

• The Administration Status field for Bay Networks routers 7.55 and above 
displays the number 1, 2, or 3, with the following meanings: 1=up, 2= dow
and 3=testing.

• RouterMan generates an Unknown Protocol message in the fault log if th
router receives a BOFL packet.

Known Problems:

• When RouterMan shows the administration status as up and the operatio
status as down, the fault symbol, performance symbol, and Fault Log do 
show or report a fault.

• On a Novell file server with routing capability turned on, the SysName, 
SysLocation, and Contact Person fields cannot be set to NULL using 
RouterMan.

• In the RouterMan Fault Log, no entry is available in the “Cause” field for 
Bay Networks routers.

• For Bay Networks routers running the VINES protocol, the Configuration 
Routing Table displays identical values in each table entry.
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Bugs Fixed

• The IF-Performance Statistics window and the IF-Performance History 
window now displays the circuit name, instead of “Index:0”. (57247)

• When you save data that spans more than one full day, the RouterMan hi
graph now correctly reports the date and time. (57430)

Segment View

These notes pertain to the Segment View application.

Operational Notes

• For some video display drivers, Segment View icons are not displayed 
properly. If this happens, Bay Networks recommends that you set your vi
display driver to 256 colors.

• Segment View does not support Model 5616 modules.

Switch Monitor

These notes pertain to the Switch Monitor application.

Operational Notes

• The Switch Monitor calculates switch port utilization on both received and
transmitted traffic. For unconnected switch ports, the utilization is nonzero
because of switch maintenance traffic. For BayStack 28115 Ethernet 
Switches, the utilization is based on received traffic only.

• The following requirements must be met before the Load Balance Manag
can properly analyze the traffic patterns among switched segments and 
provide Load Balance recommendations:

— RMON agents are required for each switch segment because the 
Load Balance Manager uses the RMON source-destination and 
destination-source matrix to analyze traffic.

— You must use the Describe feature to enter RMON into the database.
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• When you run Switch Monitor for BayStack 28000- or 58000-series switc
running in STP Mode, the Domain View and Community View are availab
even though these views are only valid when the switch is running in 
LattisSpan™ mode. In STP mode, Domain and Community views display 
invalid information.

• When you add rows to the Utilization Graph or the Error Graph for the 
BayStack Stackable Hub the row is shown as “Sx-Py” where “x” is the un
number and “y” is the port number.

Known Problems

• The Switch Monitor application does not support the Ethernet Workgroup
Switch or the Baystack 301 Desktop Ethernet Switch.

• The Switch Monitor does not support versions 1.1X and 1.2X of the BaySt
28115 Ethernet Switch agent software. Versions 1.3X, 1.4X, and all future
releases are supported.

• Switch Monitor does not display agent information for a BayStack 28000 
agent versions 2.1.0.x or 2.1.1.x. (78606)

Threshold Manager

These notes pertain to the Threshold Manager application.

Operational Notes

• Threshold Manager supports System 5000BH modules and Centillion C1
and C50 switches only if they are running version 2.2 or later. These agen
not populate the “etherStatsTable”, “tokenRingMLStatsTable”, and 
“tokenRingPStatsTable” tables automatically. To populate the table, see t
following readme file on the Optivity Campus Software CD:

<CD drive>:\wgn\unsupprt\readme.est

• The Centillion agent version 3.1 and above have “tokenRingPStatsTable”
support.

• The Threshold Manager menu item is enabled only for certain devices. It
not available for all devices.

• On the BayStack 28000 and 58000 Switches the Threshold Manager onl
supports agent version 2.1 and later.
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Known Problems

• When you run Threshold Manager for a Model 3410 NMM, the Event Log
tool bar is always deactivated.

• Threshold Manager cannot set thresholds on virtual ports of Centillion 
devices.

• Threshold Manager cannot set the following thresholds on Interfaces of 
Model 5616SA and Model 5310 NMMs and BayStack 200 and BayStack
10BASE-T hubs:

— FCS Errors

— Collisions

— Late Collisions

— Short Events

— Rate Mismatches

— Back-off Failures

— Auto-partitions

— Short IPGs

— Null Frames

• When you set thresholds on a BayStack 200, the Target list contains the 
following backplane entries: 

— Unit <unit number> Backplane 1

— Unit <unit number> Slot <slot number> Backplane 1 

Only the entry for Unit <unit number> Slot <slot number> Backplane 1 is 
valid; thresholds set for the other entry will not work.

• When you set thresholds for a BayStack 350 with version 2.0 agent, you m
set both rising and falling thresholds.

• The following error messages from Threshold manager are not documented

Apply to device operation failed on x entries. (THD-045)

Please select an available board for the filter! (THD-046)

Please select an available interface for the filter! (THD-047)

Please select an available cluster for the filter! (THD-048)

Please select an available port for the filter! (THD-049)
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Please select an available backplane for the filter! (THD-050) 

Agent Support

Table 3 shows Threshold Manager capability in relation to the agent software 
version of various devices.

Table 3. Threshold Manager Capabilities by Agent

Agent Name Versions Media, Device, and Capability
MIB-II (Rising 
and Falling)

Custom 
Actions

A331xSA 1.0, 1.2, 1.3 Ethernet—System 3000-RMON X

A331xSA-B 1.0, 1.2 Ethernet—System 3000-RMON X

A281xSA 1.0, 1.2, 1.3 Ethernet—System 2000-RMON X

A271xSA 1.0, 1.2 Token ring—System 2000-RMON X

A351xSA 1.0, 1.2, 1.3 Token ring—System 3000-RMON X

A331x, A331x-B 4.0, 4.1, 4.2 Ethernet—System 3000-Proprietary

B331x, B331x-B 4.2, 5.1 Ethernet—System 3000-Proprietary

A331x, A331x-B 5.1, 5.2, 5.3 Ethernet—System 3000-RMON X

B331x, B331x-B 5.1, 5.2, 5.3 Ethernet—System 3000-RMON X

A331xA, A331xA-B 4.2 Ethernet—System 3000-Proprietary

A331xA, A331xA-B 5.1, 5.2, 5.3 Ethernet—System 3000-RMON X

B331xA, B331xA-B 5.1, 5.2, 5.3 Ethernet—System 3000-RMON X

A331xS, A331xS-B 4.1, 4.2 Ethernet—System 3000-Proprietary

A331xS, A331xS-B 5.1, 5.2, 5.3 Ethernet—System 3000-RMON X

A281x 4.2 Ethernet—System 2000-Proprietary

A281x, B281x 5.1, 5.3 Ethernet—System 2000-RMON X

A271x 4.0, 4.1, 4.2, 
4.3, 4.4, 5.0

Token ring—System 2000-Proprietary

Token ring—System 3000-ProprietaryA351x 4.0, 4.1, 4.2, 
4.3, 4.4, 5.0

A2810 4.0 Ethernet—System 2000-Proprietary

531x 1.1, 1.2, 1.3, 
1.4, 1.5

Ethernet—System 5000-RMON X

551x 1.1, 1.2, 1.3 Token ring—System 5000-RMON X

5510A 1.2, 1.3, 1.4, 
1.5, 1.6, 2.0

Token ring—System 5000-RMON X
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561x 1.0 Ethernet—System 5000-RMON X

341x 1.1 Ethernet—System 5000-RMON X

Centillion C100 2.2, 3.0, 3.1 Ethernet or token ring—
Centillion-RMON

Centillion C50 2.2, 3.0, 3.1 Ethernet or token ring—
Centillion-RMON

System 5000BH 2.2, 3.0, 3.1 Ethernet or token ring—
Centillion-RMON

BayStack 10x 1.3, 1.4, 1.5, 2.0 Ethernet—System 5000-RMON except 1.3

BayStack 150 1.0, 2.0 Ethernet—System 5000-RMON only 2.0

BayStack 200 1.0, 3.1 Ethernet—System 5000-RMON

BayStack 201 1.1, 3.1 Ethernet—System 5000-RMON X

BayStack 250 1.0, 3.1 Ethernet—System 5000-RMON X

BayStack 303 2.0, 2.1 Ethernet—Workgroup-RMON

BayStack 304 2.0, 2.1 Ethernet—Workgroup-RMON

BayStack 350 2.2 Ethernet—Workgroup-RMON

BayStack 50x 1.0, 1.1, 1.2 Token ring—System 5000-RMON

BayStack 450 1.1 Ethernet-Workgroup-RMON

BayStack 350 12T, 
24T

1.0 Ethernet- Workgroup-RMON

BayStack 28115 2.1 Ethernet-Workgroup-RMON

BayStack 58000 2.1 Ethernet-Workgroup-RMON

Table 3. Threshold Manager Capabilities by Agent (continued)

Agent Name Versions Media, Device, and Capability MIB-II (Rising 
and Falling)

Custom 
Actions
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Bay Networks Technical Publications

You can now print Bay Networks technical manuals and release notes free, 
directly from the Internet. Go to support.baynetworks.com/library/tpubs/. Find the 
Bay Networks product for which you need documentation. Then locate the 
specific category and model or version for your hardware or software product. 
Using Adobe Acrobat Reader, you can open the manuals and release notes, 
for the sections you need, and print them on most standard printers. You can
download Acrobat Reader free from the Adobe Systems Web site, 
www.adobe.com.

You can purchase Bay Networks documentation sets, CDs, and selected tec
publications through the Bay Networks Collateral Catalog. The catalog is loca
on the World Wide Web at support.baynetworks.com/catalog.html and is divided 
into sections arranged alphabetically: 

• The “CD ROMs” section lists available CDs.

• The “Guides/Books” section lists books on technical topics.

• The “Technical Manuals” section lists available printed documentation se

Make a note of the part numbers and prices of the items that you want to ord
Use the “Marketing Collateral Catalog description” link to place an order and 
print the order form.

How to Get Help

For product assistance, support contracts, or information about educational 
services, go to the following URL:

http://www.baynetworks.com/corporate/contacts/
896-007-M 37




	Release Notes for Optivity Campus 7.0.1
	Contents
	Introduction
	New Features
	New Hardware Support
	Agent Support
	Operating System Support
	Operational Notes
	General
	Installation
	Platform Software
	HP OpenView Workgroup Node Manager
	HP OpenView NNM and Tivoli TME 10 NetView

	Agent Software
	Topology
	IPX Protocol
	Miscellaneous Problems

	Application Notes
	Agent Manager
	Operational Notes
	Known Problems

	Alarm Manager
	Operational Notes
	Known Problems
	Bugs Fixed

	Campus Command Center
	Operational Notes
	Bugs Fixed

	Device Manager (For Accelar Routing Switches)
	Operational Notes

	Expanded View
	Operational Notes
	Known Problems
	Bugs Fixed

	Flat Network View
	Operational Notes
	Known Problems

	LANarchitect
	Operational Notes
	Known Problems
	Bugs Fixed

	Nodal View
	Operational Notes
	Known Problem
	Bugs Fixed

	Node Security Manager
	Out-of-Band Manager
	Report Manager
	Operational Notes
	Known Problems
	Bugs Fixed

	Ring Manager
	Operational Notes
	Bugs Fixed

	RMON Applications
	Operational Notes
	Known Problems:
	Bug Fixed

	RouterMan
	Operational Notes
	Known Problems:
	Bugs Fixed

	Segment View
	Operational Notes

	Switch Monitor
	Operational Notes
	Known Problems

	Threshold Manager
	Operational Notes
	Known Problems
	Agent Support


	Bay Networks Technical Publications
	How to Get Help


